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Overview 

A bending machine bends metal plates by holding them between its upper and lower frames 

and applying pressure to the plate. Different bending frames bend plates into different angles 

and shapes.  

The shapes of the frames determine how a bending machine deforms the metal plate. The 

force applied by the bending machine creates a stress that exceeds the yield stress of the 

plate, so the plate is permanently deformed (plastic deformation). Therefore, to understand 

the plastic behavior of a metal plate, you must perform a plastic analysis rather than an 

elastic analysis. 

To perform a plastic analysis, you must give a flexible body modeled in RecurDyn with plastic 

properties instead of elastic properties and simulate the behavior of the flexible body. 

In this tutorial, you will learn how to assign plastic properties to a dynamic model composed 

of flexible bodies and perform a plastic analysis. You will also learn about the characteristics 

of a plastic analysis by comparing the results of the analysis to the results obtained using an 

elastic material. 

Task Objective 

This tutorial covers the following topics: 

▪ Elastic analysis of the behavior of a flexible body 

▪ Requirements for performing a plastic analysis 

▪ How to apply plastic properties to an analysis model and the characteristics of plastic 

analysis 

▪ How to analyze the results of a plastic analysis 

▪ Differences between an elastic analysis and a plastic analysis 
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Prerequisites  

This tutorial is intended for users who have completed the Basic and FFlex/RFlex tutorials 

provided with RecurDyn. If you have not completed these tutorials, then you should complete 

them before proceeding with this tutorial. In addition, this tutorial requires a basic 

understanding of dynamics and the finite element method. 

Tasks 

The following table outlines the tasks involved in this tutorial and their duration. 

 

Procedure Time (minutes) 

Opening the Initial Model 5 

Generating a FFlex Body 20 

Performing an Elastic Analysis 10 

Performing a Plastic Analysis 5 

Analyzing and Reviewing the Results 10 

Total 65 

 

Estimated Time to Complete  

This tutorial takes approximately 65 minutes to complete. 
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Opening the Initial Model 

Task Objective 

Open the initial model, perform a simulation, and observe the behavior of the bending 

machine. 

 

Estimated Time to Complete  

5 minutes 

  

Chapter 
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Opening the RecurDyn Model 

To run RecurDyn and open the initial model: 

1. On the Desktop, double-click the RecurDyn icon to open RecurDyn.  

2. When the Start RecurDyn dialog window appears, close it. 

3. In the File menu, click Open. 

4. Navigate to the Plasticity tutorial folder and select 

Plasticity_Bending_Machine_Start.rdyn.   (File path: <Install 

Dir>\Help\Tutorial\Flexible\FFlex\Plasticity_Bending_Machine). 

5. Click the Open button to open the model shown in the following figure. 

 

The following explains the configuration of the 

model. 

The figure on the right shows a type of bending 

machine. The motor turns the gear to raise the 

transfer device. When the transfer device reaches 

the final tooth on the gear, the transfer device 

drops to strike the metal plate (placed on the die) 

with the punch.  

The figure on the right does not include the metal 

plate. Later in this tutorial, you will learn how to 

model a metal plate using a flexible body. To do so, 

you model a metal plate with plastic properties on 

top of the die. The energy of the falling punch and 

transfer device is applied to the metal plate through 

an impact to deform it.  

When the punch hits it, the metal plate deforms in 

the shape of the die. The teeth on the gear then 

engages the teeth on the transfer device to raise 

the punch again.  

The model used in this tutorial consists of a die, 

punch, transfer device, motor fixture, and gear. You 

will model the metal plate later in the tutorial. 

To save the model: 

1. In the File menu, click Save As. 

(You cannot perform the simulation if the 

model is in the tutorial path, so you must save 

the model in a different path.) 
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Simulating the Initial Suspension Model 

This section teaches you how to conduct an initial simulation using the model in order to 

understand its behavior. 

To perform the initial simulation: 

1. On the Analysis tab, in the Simulation 

Type group, click the Dyn/Kin icon. 

The Dynamic/Kinematic Analysis dialog 

window appears. 

2. Set the End Time and Step fields as 

follows: 

▪ End Time: 2 

▪ Step: 200 

▪ Plot Multiplier Step Factor: 1 

3. Click Simulate.  

 

 

 

 

Viewing the Result  

To view the results: 

On the Analysis tab, in the Animation Control group, click the Play button.  

In the work pane, the motor turns the gear to raise the transfer device. After the transfer 

device passes the final tooth on the gear, the punch falls and strikes the die. The gear then 

engages the transfer device again to raise it. 
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Generating a FFlex Body 

As mentioned previously, the current RecurDyn model does not include the metal plate model 

needed to perform plastic analysis. Therefore, to create the flexible body for the metal plate, 

you must first create a rigid body using the box geometry provided in RecurDyn. Then, you 

can transform the rigid body into a flexible body using the Mesher. You must also define the 

contact points between the metal plate and die as well as the metal plate and punch. 

Task Objectives 

This task teaches you how to replace the newly created rigid body with a flexible body using 

the Mesher provided in RecurDyn/FFlex (Full Flex). 

Estimated Time to Complete 

20 minutes 
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Creating the Box Geometry 

1. On the Professional tab, in the Body group, click the Box icon. 

2. In the Modeling Options dropdown menu, select Point, Point, and then type the 

following values in the Command Input field.  

-75, 0, 35 (Press Enter after typing the values.)  

75, -2, -35 (Press Enter after typing the values.)  

3. After you enter the values, the box geometry (shown below) appears. In the Database 

pane, change the name of Body1 to Plate. 
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Creating the Box Mesh 

1. In Assembly mode, right-click the work pane to display the context menu and click 

Mesh.  

Mesh mode displays only the plate body, as shown below.  

 

2. On the Geometry tab, in the Surface group, select Face Surface.  

3. Select Box1 to open the FaceSurf Operation dialog window. With the FaceSurf 

Operation dialog window open, select Box1.Face4 on top of the box.  

4. When Face4 appears in the dialog window (shown below), click the OK button to create 

FaceSurface1. 
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5. On the Mesher tab, click the Mesh icon to 

open the Mesh dialog window. 

6. In the Mesh dialog window, perform the 

following: 

▪ In the Target Geometry option, Click 

the Gr button then select 

FaceSurface1. 

▪ In the Mesh Type dropdown menu, 

select Shell4(Quad4). 

▪ In the Mesh Option pane, set both the 

Max Element Size and Min Element Size 

to 3. 

▪ Click the Mesh button. 

▪ Click the Cancel button.  

 

 

 

 

 

 

 

  



P L A S T I C I T Y  B E N D I N G  M A C H I N E  T U T O R I A L  ( F F L E X )  

13 

 

7. In the Database pane, under the newly created Plate_FE, right-click PShell1, and 

then click Property in the context menu to open the Property dialog window.  

 

8. In the Property dialog window, click the … button to 

the right of No. 2 PShell1. When the Property Shell 

dialog window appears, change the Thickness from 

10 to 0.5, and then click the Close button.  

9. In the Property dialog window, click the Mt. button 

to the right of No. 2 PShell1. The Material dialog 

window appears (shown below). 

▪ In the Material dialog window, click the …  button to the right of No. 2, and then 

change the following settings:  
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▪ Change the Young’s Modulus value from 200,000 to 150,000. 

▪ Select nu, and then change Poisson’s Ratio to 0.3. Then, click the Close button. 

▪ Click the OK button twice to close all open dialog windows. 

10. In the FFlex Edit group, click the B.C icon. When the B.C. Current Unit dialog window 

appears, click the Add/Remove button. 

▪ Press Shift and Z at the same time to change the working plane to the ZX plane. 

Then, click and drag the mouse to select the nodes located at the center of the 

plane. 

 

▪ Once you select the nodes on which to apply the B.C., right-click the screen and 

select Finish Operation from the context menu. (For your information, the ID 

of the leftmost node is 50103.) 

▪ When the B.C. Property dialog window appears again, clear the Y checkbox, as 

shown below. Click the OK button to see the new boundary conditions created 

on the screen.  

11. Use one of the following methods to return to a higher menu: 

▪ Right-click the working pane to display the context menu, and then click Exit. 

▪ On the Mesher tab, in the Exit group, click the Exit icon. 

 

Tip: Setting the boundary conditions for the FFlex Body as such removes the constraint on the 

Y axis (the direction in which the punch travels) but maintains the constraint for the remaining 

DOFs in the center of the plate, where deformation is not expected to occur, in order to increase 

the speed of analysis. 
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Performing Elastic Analysis 

Task Objectives 

In this chapter, you will learn how to conduct dynamic modeling and analysis on a FFlex Body 

and check the results of the analysis.  

Estimated Time to Complete  

10 minutes 
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Performing Dynamic Modeling 

To create a patch set: 

1. Double-click the Plate_FE body to enter Body Edit mode.  

2. On the FFlex Edit tab, in the Set group, click the Patch Set icon.  

3. When the Patch Set dialog window appears, click the Add/Remove button. Then, in the 

work pane, click and drag the mouse to select the whole body. 

 

4. Right-click the work pane to display the context menu, and then click Finish Operation. 

5. In the Patch Set dialog window, click the OK button. 

▪ Confirm that SetPatch1 appears in the Database pane. 

6. Click the Patch Set icon again and repeat steps 3 and 4 to create another patch set. In 

the Patch Set dialog window, select the Preview Normal checkbox, as shown below. 

Then, in the Automatic row of the Normal Adjust pane, click the Switch button. (This 

process creates two patch sets to define the contacts on both sides of the shell.) 
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7. In the Patch Set dialog window, click the OK button. 

▪ Confirm that SetPatch2 appears in the Database pane. 

8. On the FFlex Edit tab, in the Exit group, click the Exit icon to return to a higher menu. 

To create a contact: 

1. On the Professional tab, in the Contact group, click the Geo Surface Contact icon. Then, 

in the Modeling Option dropdown menu, select Surface(PatchSet), 

Surface(PatchSet), as shown below.  

2. Select Punch.FaceSurface1, which will be designated as the base body for the geo 

surface contact, and Plate_FE.SetPatch1, which will be designated as the action body. 

Confirm that GeoSurContact3 is created in the Database pane.  

3. Click the Geo Surface Contact icon again. Then, select the areas that will become the 

base and action bodies for the geo surface contact, as shown below, to create 

GeoSurfaceContact4.  

▪ For the base body, select Die.FaceSurface1.  
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▪ For the action body, it is difficult to select Plate_FE.SetPatch2 in the work pane. 

So, right-click the screen to display the context menu, and then click Select List. 

When the Select List dialog window appears, select the Plate_FE.SetPatch2 

checkbox. 

 

4. To see if the geo surface contacts are set properly, right-click GeoSurfaceContact4 to 

open the Property dialog window.  

 

5. In the Definition of the Action Geometry pane, click the Contact Geometry button. 

When the Surface Patch dialog window appears, change the Bounding Buffer Length 

to 25. 
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6. Perform the same process for GeoSurContact3, but leave the Normal Direction set to 

Up. Only change the Bounding Buffer Length for Plate_FE.SetPatch1 to 25. 
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Performing Elastic Analysis  

In this procedure, you will learn how to perform a simulation on the FFlex body created 

earlier and the contacts defined for elastic analysis. 

To run the simulation: 

1. On the Analysis tab, in the Simulation Type 

group, click the Dyn/Kin icon. 

The Dynamic/Kinematic Analysis dialog window 

appears. 

2. Set the End Time and Step fields as follows:  

▪ End Time: 2 

▪ Step: 200 

▪ Plot Multiplier Step Factor: 1 

3. Click Simulate. 

 

 

 

To view the results: 

On the Analysis tab, in the Animation Control 

group, click the Play button.  

 

Unlike the transfer device in previous simulation, in which 

the punch came into direct contact with the die, the 

transfer device in this simulation behaves differently 

because the contact occurs between the Plate_FE flexible 

body and the punch and die.  

The Plate_FE flexible body acts as a spring when the punch 

falls on it, and the transfer device rebound upwards. This 

phenomenon does not occur in real life. The reason why 

this phenomenon occurs is because the Plate_FE flexible 

body has only elasticity, not plasticity. Therefore, even 

though a large amount of deformation occurs, the flexible 

body return to its original state, springing the transfer 

device upwards.  

Due to this spring effect, the transfer device is raised 

without the help of the gear and must remain aloft until the 

final gear tooth.  

Therefore, to realistically simulate the deformation of a 

metal plate and the operation of a transfer device, you 

must add plasticity to the flexible body and perform plastic 

analysis rather than elastic analysis. 
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To check the contour results: 

1. On the Flexible tab, in the FFlex group, click the Contour icon. 

The Contour dialog window appears. 

2. In the Contour dialog window, perform the following:  

▪ Click the Calculation button in the middle of the dialog window. 

▪ Select the Show Min/Max checkbox. 

▪ Click the OK button to see the results. 

 

3. On the Analysis tab, in the Animation Control group, click the Play button.  

▪ To see the contour result for Plate_FE, as shown below, click the Wireframe icon 

in the Toolbar and run the animation. 

▪ At 1.24 seconds, you can see that the Maximum Von-Mises Stress is 

approximately 2652 MPa. 
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Performing Plastic Analysis 

Task Objectives 

In this chapter, you will learn how to apply plastic properties to an FFlex body and check the 

results after performing plastic analysis.   

Estimated Time to Complete 

20 minutes 

  

Chapter 
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Performing Plastic Modeling (1) 

To create a plastic material: 

1. Double-click the Plate_FE body to enter Body Edit mode.  

2. In the Database pane, right-click Plate_FE, and then click Edit in the context  

3. menu. Then, double-click Mat_Property_2 to open the Material Property dialog 

window, as shown below. 

4. In the Material dialog window, select Plastic / Isotropic in the dropdown menu to the 

right of Mat_Property_2 (No. 2). Then, click the … button to display the Plastic – 

Isotropic dialog window. 

5. In the Plastic – Isotropic dialog window, perform the 

following: 

▪ Change the Young’s Modulus value from 200,000 

to 150,000. 

▪ Select the Nu radio button and change Poisson’s 

Ratio to 0.3. 

▪ In the Multi-linear pane, click the Add button to 

add a new row. Then, type in the Plastic Strain 

and Yield Stress values shown in the following 

table. 
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6. To ensure that the values entered in the previous step are correct, in the Diagram 

pane, click the Draw button to the right of the Stress-Strain Relation menu and 

ensure that the graph resembles the graph shown below. 

 

7. In the FFlex Edit group, click the Output icon. When the Output Current Unit dialog 

window appears, click the Add/Remove button.  

▪  Hold down the Shift key and click the five nodes (50032, 50030, 50028, 50026, 

and 50024), as shown below.  

▪ After selecting the nodes, right-click the work pane to display the context menu, 

and then click Finish Operation. 

8. In the Outputs dialog window, click the OK button. 

 

 

9. On the FFlex Edit tab, in the Exit group, click the Exit icon to return to a higher menu. 

10. In the File menu, click Save As. Then, save the model as 

Plasticity_Bending_Machine_Isotropic.rdyn. 
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Performing Plastic Analysis (1) 

To see the results of the plastic analysis for the plastic material, you must run the simulation. 

To run the simulation: 

1. On the Analysis tab, in the Simulation Type 

group, click the Dyn/Kin icon. 

The Dynamic/Kinematic Analysis dialog 

window appears. 

2. Set the End Time and Step fields as follows: 

▪ End Time: 2 

▪ Step: 200 

▪ Plot Multiplier Step Factor: 1 

▪ Output File Name: Isotropic_Plasticity 

3. Click Simulate. 
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To view the results: 

On the Analysis tab, in the Animation Control group, click the 

Play button.  

Unlike the results of the elastic analysis, the metal plate in the 

plastic analysis remains in the V-shape of the die after the punch 

strikes.  

In addition, the spring effect from the elasticity has disappeared, 

so the transfer device does not rebound. Because of this, the 

transfer device is raised again when the gear engages the teeth 

on the transfer device again, and the process is repeated. 
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To check the contour results: 

1. On the Flexible tab, in the FFlex group, click the Contour icon to display the Contour 

dialog window. 

2. In the Contour dialog window, perform the following:  

▪ Click the Calculation button in the middle of the dialog window. 

▪ Select the Show Min/Max checkbox. 

▪ Click the OK button to see the results.  

3. On the Analysis tab, in the Animation Control group, click the Play button.  

 

▪ To see the contour result for Plate_FE, as shown below, click the Wireframe icon 

in the Toolbar and run the animation. 

▪ You can see that, at 1.23 seconds, the Maximum Von-Mises Stress is 

approximately 295.22 MPa. After 1.52 seconds, approximately 227.36 MPa of 

residual stress remains.  
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Performing Plastic Modeling (2) 

To create a plastic material: 

1. Double-click the Plate_FE body to enter Body Edit mode.  

2. In the Database pane, right-click Plate_FE, and then select Edit in the context menu. 

Then, double-click Mat_Property_2 to open the Material Property dialog window, as 

shown below. 

 

3. In the Material dialog window, select Plastic / Isotropic + Kinematic in the 

dropdown menu to the right of Mat_Property_2 (No. 2). Then, click the … button to 

display the Plastic – Isotropic-Kinematic dialog window. 

4. In the Plastic – Isotropic-Kinematic dialog window, perform the following: (If you 

carried out the procedure described in Performing Plastic Modeling (1), you don't need to 

change the Young’s Modulus and Nu options.) 



P L A S T I C I T Y  B E N D I N G  M A C H I N E  T U T O R I A L  ( F F L E X )  

31 

 

▪ Change the Young’s Modulus value from 200,000 

to 150,000. 

▪ Select the Nu radio button and change Poisson’s 

Ratio to 0.3. 

▪ In the Multi-linear pane, click the Add button to 

add a new row. Then, type in the Plastic Strain 

and Yield Stress values shown in the upper table. 

 

▪ In the Kinematic Hardening (Hk) field, type 160. 

5. To ensure that the values entered in the previous step 

are correct, in the Diagram pane, click the Draw button to the right of the Stress-

Strain Relation menu. Ensure that the graph resembles the one shown below. 

 

 

6. On the FFlex Edit tab, in the Exit group, click the Exit icon to return to a higher menu. 

In the File menu, click Save As, and save the model as 

Plasticity_Bending_Machine_Isotropic_Kinematic.rdyn. 
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Performing Plastic Analysis (2) 

To see the results of the plastic analysis for the plastic material, you must run another 

simulation. 

To run the simulation: 

1. On the Analysis tab, in the Simulation Type 

group, click the Dyn/Kin icon. 

The Dynamic/Kinematic Analysis dialog window 

appears. 

2. Set the End Time and Step fields as follows: 

▪ End Time: 2 

▪ Step: 200 

▪ Plot Multiplier Step Factor: 1 

▪ Output File Name: 

Isotropic_Kinematic_Plasticity 

3. Click Simulate. 

 

To view the results: 

On the Analysis tab, in the Animation Control group, 

click the Play button.  

Just like the results of Performing Plastic Analysis (1), the metal 

plate in this simulation maintains the V shape of the die after the 

punch strikes it.  

Because of this, the transfer device is raised again when the gear 

engages the teeth on the transfer device, and the process is 

repeated. 
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To check the contour results: 

1. On the Flexible tab, in the FFlex group, click the Contour icon to display the Contour 

dialog window. 

2. In the Contour dialog window, perform the following:  

▪ Click the Calculation button in the middle of the dialog window. 

▪ “Select the Show Min/Max checkbox. 

▪ Click the OK button to see the results.  

 

3. On the Analysis tab, in the Animation Control group, click the Play button.  

▪ To see the contour result for Plate_FE, as shown below, click the Wireframe icon 

in the Toolbar and run the animation. 

▪ You can see that, at 1.23 seconds, the Maximum Von-Mises Stress is 

approximately 298.38 MPa. After 1.53 seconds, approximately 252.62 MPa of 

residual stress remains. 
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Analyzing and Reviewing the 

Results 

Task Objectives 

This chapter analyzes the results of the two plastic analyses using different plastic materials 

and compares these analyses with the elastic analysis results. 

Estimated Time to Complete 

10 minutes 

  

Chapter 

6 
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Analyzing the Plastic Analysis Results 

Theoretical Explanation of Metal Plasticity 

In the final analysis from the previous chapter, the metal plate modeled using a flexible body 

underwent plastic deformation due to the force of the punch striking it. The stress generated 

at the time of deformation is called yield stress. The stress can be expressed as a three-

dimensional shape, such as a sphere or cube, by specifying the amount of stress along the X, 

Y, and Z axes in the three-dimensional space. The surface of such a sphere or cube is called 

the yield surface. 

If the load is applied again to the flexible material constituting the metal plate after the 

material has passed from the elastic range into the plastic range, then the yield stress of the 

material increases along with the deformation of the material. This process is called 

hardening. Hardening is a fundamental property of a plastic material. RecurDyn can model 

two types of hardening.  

The first is isotropic hardening, in which the yield surface of the stress sphere expands in all 

directions at the same rate. The second one is kinematic hardening, in which the size of the 

yield surface remains the same, but the center of the surface shifts.  

If only isotropic hardening is used, when the tensile load is removed and a compressive load 

is applied after the material has entered the plastic range, the yield stress of the material 

changes from +Y to –Y (Y - 2 × Y). During this process, the stress-strain relationship of the 

material shows linear elastic behavior.  

If only kinematic hardening is used, when the tensile load is removed and the compressive 

load is applied after the yield stress has exceeded the initial yield stress (I) and the material 

has entered the plastic range, the yield stress of the material changes from +Y to Y - 2 × I. 

During this process, the stress-strain relationship of the material shows linear elastic 

behavior. 
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RecurDyn provides two different hardening options. The first option allows for only using 

isotropic hardening. The second option is to use isotropic + kinematic hardening, which 

combines both isotropic hardening and kinematic hardening.  

In the bending machine used for this tutorial, no additional force is applied after the punch 

falls on the metal plate to cause deformation. Therefore, there is not much physical 

difference between isotropic hardening and kinematic hardening. However, if you use a non-

zero value for Kinematic Hardening (Hk), the effective hardening modulus changes, causing 

the slope in the plastic range (plastic modulus) to change and leading to different residual 

stress and permanent strain results.  

Comparing the Results of Plastic Analyses (1) and (2) 

To compare the plot results:  

1. On the Analysis tab, in the Plot group, click Plot to enter Plot mode. 

The Modeling work pane changes to the Plot work pane.  

2. On the Home tab, in the Import and Export group, click Import. 

In the Import dialog window, select the *.rplt files created from the two plastic 

analyses. 

▪ In the output folder created in the first analysis, select Isotropic_Plasticity.rplt. 

▪ Click the Import icon again and, in the output folder created after the second 

simulation, select Isotropic_Kinematic_Plasticity.rplt. (If you entered Plot 

mode directly after finishing the Isotropic+Kinematic analysis, then this file is 

imported automatically.) 

3. As shown in the figure below, the data from both rplt files appears in the Database 

pane. 
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▪ Click the + button to the left of Isotropic_Plasticity. In the expanded tree, click 

the + button to the left of FFlex_Bodies-Plate_FE.Output1-

Plate_FE_Node5032, Shell-Bottom, and then select EMISES_T. 

▪ Right-click EMISES_T to display the context menu, and then click Multi Draw.  

 

4. Two graphs appear in the Plot work 

pane, as shown in the figures to the 

right.  

To match the figure shown on the right, 

right-click SMISES instead of 

EMISES_T in step 3 and select Multi 

Draw.  

 

 

Analyzing the Results 

The graphs drawn in the preceding procedure indicate the following: 

The total strain is composed of the combination of plastic strain and elastic strain. The plastic 

strain causes the permanent deformation of the metal plate. Also, a difference can be 

detected between the behavior of plasticity with isotropic hardening and plasticity with 

isotropic + kinematic hardening. As was explained earlier, this is due to the difference in the 

slope of the plastic range. 

As you can see in the Von-Mises stress results, the metal plate maintains a certain residual 

stress after deformation of the plate occurs due to outside impact. 
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For Reference 

Multi-linear Models 

The stress-strain relationship for the plastic range can be expressed using a formula. This 

tutorial used a multi-linear model that calculates the plastic modulus using multiple linear 

data. This method extracts the plastic strain and yield stress values from empirical results 

obtained from experiments and uses the values to generate a multi-linear model.  

As shown in the figure above, you can obtain the Plastic Strain(x) and Yield Stress(y) values 

through experiments and enter the values in the Multi-linear pane of the Plastic – 

Isotropic dialog window to create the blue stress-strain graph. In the stress-strain graph, 

the strain in the plastic range is the total strain that consists of both the plastic strain and 

elastic strain. Therefore, you must ensure that you enter only the plastic strain when you 

enter the data in the Multi-linear pane. In the experiment, you can obtain the plastic strain by 

applying a load larger than the yield stress and measuring the degree of deformation in the 

material. 

 

 

 

 

 

Thanks for participating in this tutorial! 
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